
1 Tvorba dynamickcýh dokument̊u

1.1 Základńı informace o dynamických dokumentech

Velmi užitečným nástrojem pro vytvářeńı efektivńıch report̊u analýzy dat je funkce Sweave. Tato funkce, implemen-
tovaná v programovaćım jazyce umožňuje integraci kódu do LATEXových dokument̊u. Zmı́něná integrace nám
umožňuje vytvářet tzv. dynamické dokumenty. Dynamický dokument je klasický LATEXový dokument sestávaj́ıćı z
pevné a dynamické složky.

Pevná složka se nič́ım nelǐśı od zdrojového kódu klasického LATEXového dokumentu. Sestává ze dvou část́ı, a sice
hlavičky a těla dokumentu. Hlavička dokumentu determinuje vzhled a nastaveńı celého dokumentu (jazyk vysázeného
textu, nač́ıtáńı baĺıčk̊u, rozložeńı stránek, nastaveńı č́ıtač̊u, definováńı nových prostřed́ı a př́ıkaz̊u, nastaveńı index̊u
a rejstř́ık̊u, apod.). Tělo dokumentu potom slouž́ı jako prostor pro sazbu a formátováńı klasického či matematického
textu, vytvářeńı seznamů, vkládáńı obrázk̊u a část́ı kódu, tvorbu tabulek, apod. Stejně jako v klasickém LATEXovém
dokumentu je obsah těla dokumentu pevný a neměnný. Např́ıklad každý obrázek je pouze načteńım a zobrazeńım
exterńıho obrázku, přičemž změna obsahu obrázku je možná pouze prostřednictv́ım změny v exterńım obrázku.
Stejně tak tabulka vysázená v těle dokumentu je přesně determinována vysázenými hodnotami a jakákoli změna v
tabulce je možná pouze ručńım přepisem hodnot.

Dynamická složka umožňuje vznik dynamického obsahu dokumentu. Vytvář́ıme ji v rámci těla dokumentu
definováńım tzv. dynamických prostřed́ı (angl. chunks1.), což jsou prostřed́ı obsahuj́ıćı kód. kód umı́stěný v

dynamickém prostřed́ı se chová jako klasický kód vytvořený např́ıklad v skriptu. Nestanov́ıme-li jinak, docháźı
při každé kompilaci zdrojového kódu k vyhodnoceńı kódu umı́stěného v dynamickém prostřed́ı a k zobrazeńı
jeho výstup̊u ve zkompilovaném dokumentu. Forma výstup̊u zcela záviśı na volbě uživatele. Výstupy tak mohou být
zobrazovány např́ıklad jako č́ıselné hodnoty, obrázky, tabulky, animace, atd. Umı́stěńı výstup̊u ve zkompilovaném
dokumentu bývá zpravidla ve stejné části textu, v jaké se nacháźı dynamické prostřed́ı v těle dokumentu. V př́ıpadě
nedostatku mı́sta na stránce jsou výstupy umı́stěny na nejbližš́ı možné pozici. Oproti pevné složce má dynamické
složka tu výhodu, že jakákoli změna v provedeném kódu či jeho výstupech se po kompilaci souboru automaticky
promı́tne do zkompilovaného dokumentu.

1.2 Nastaveńı R Sweave

1.2.1 Instalace softwaru

Abychom mohli plně využ́ıvat komfortu dynamických dokument̊u, muśıme si pro jejich tvorbu nejprve přichystat
potřebný software. Předně je nezbytné mı́t v poč́ıtači staženou a nainstalovanou nejlépe aktuálńı verzi programo-
vaćıho jazyku . Nastaveńı R Sweave, stejně jako následnou tvoru dynamických dokument̊u výrazně usnadňuje
a zpř́ıjemňuje nadstavbový software RStudio, proto silně doporučujeme také instalaci aktuálńı verze tohoto soft-
waru. Dále je třeba mı́t v poč́ıtači nainstalovaný software na sazbu a kompilaci TEXu a LATEXu. Jako vhodný
sázećı systém doporučujeme zvolit software MikTeX, který se v souvislosti s tvorbou dynamických dokument̊u
prostřednictv́ım R Sweave osvědčil. Tento software bývá v souvislosti s R Sweave a tvorbou dynamických doku-
ment̊u také nejčastěji doporučovaný komunitou uživatel̊u . Software MikTeX je volně dostupný ke stažeńı na
stránce https://miktex.org/ pro všechny v Česku a na Slovensku nejčastěji využ́ıvané platformy, jako jsou Windows,

Mac, Linux a Docker. Uživatel̊um Macu bývá př́ıpadně komunitou uživatel̊u také doporučován sázećı systém
MacTeX, volně dostupný ke stažeńı na stránce https://rpubs.com/YaRrr/SweaveIntro. Nejen uživatel̊um, kteř́ı se
nećıt́ı být silńı ve znalostech LATEXu, d̊urazně doporučujeme také instalaci vhodného LATEXového editoru, který se
při tvorbě dynamických dokument̊u záhy ukáže jako neocenitelný pomocńık při hledáńı chyb ve zdrojovém kódu. Z
nejznáměǰśıch editor̊u uvád́ıme pro př́ıklad editory TeXmaker, TeXnicCenter nebo TeX Live. Z uvedených editor̊u
doporučujeme prax́ı prověřený editor TeXmaker v kombinaci se sázećım systémem MikTeX, nebo editor TeX Live
v kombinaci se sázećım systémem MacTeX.

1Anglický pojem chunk bývá v českých textech bud’ ponecháván v nezměněné podobě, nebo překládán formou fonetického přepisu
(čank). Protože však ani jeden př́ıstup neńı správný, v tomto textu se podobnému názvoslov́ı vyhneme a nahrad́ıme jej právě pojmem
dynamické prostřed́ı.
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1.2.2 Instalace baĺıčk̊u knitr a xtable

Po dokončeńı instalace potřebného softwaru zbývá doladit několik detail̊u týkaj́ıćıch se programovaćıho jazyka
a nastaveńı RStudia. Nejprve je třeba stáhnout a nainstalovat baĺıčky knitr a xtable. Instalaci baĺıčk̊u provedeme v
RStudiu bud’ ručně prostřednictv́ım záložky Packages v multifunkčńım okně, nebo zadáńım následuj́ıćıch př́ıkaz̊u
do konzole.

1 install.packages(’knitr’)

2 install.packages(’xtable ’)

Poznámka: Baĺıček knitr vznikl spojeńım několika baĺıčk̊u a funkćı, které pr̊uběžně vznikaly za účelem poho-
dlné tvorby dynamických dokument̊u prostřednictv́ım funkce Sweave(). Součást́ı baĺıčku knitr jsou např́ıklad sa-

motná funkce Sweave(), baĺıčky cacheSweave a weaver umožňuj́ıćı ukládáńı výsledk̊u kódu do mezipaměti, č́ımž

docháźı k významnému zkráceńı výpočetńı doby kódu, a tedy i doby kompilace celého zdrojového kódu, baĺıček
pgfSweave, který umožňuje ukládáńı grafiky do mezipaměti (v návaznosti na baĺıček cacheSweave) a zajǐst’uje ba-

revné zvýrazněńı kódu zobrazeného jako výstup ve zkompilovaném dokumentu, funkce saveLatex() z baĺıčku
animation umožňuj́ıćı tvorbu animaćı, apod. Baĺıček knitr dále disponuje nově vytvořenými funkcemi i r̊uznými mo-
difikacemi a nadstavbami funkćı z výše uvedených baĺıčk̊u, které společně zjednodušuj́ı tvorbu výstup̊u (např́ıklad

umožňuj́ı př́ımé vykresleńı graf̊u bez nutnosti použit́ı funkce print()) a zvyšuj́ı transparentnost výstup̊u kódu
(např́ıklad poskytuj́ı volbu mezi výpisem a potlačeńım výpisu varovné hlášky, je-li tato hláška součást́ı výstupu

funkce). S touto bohatou výbavou poskytuje baĺıček knitr kompletńı soubor funkćı potřebných pro co nejpoho-

dlněǰśı tvorbu kódu v dynamickém prostřed́ı, efektivńı spuštěńı kódu, hladké vyhodoceńı jednotlivých př́ıkaz̊u
a zařazeńı výstup̊u kódu ve správném tvaru a na správnou pozici do zkompilovaného dokumentu.

Baĺıček xtable slouž́ı ke konverzi tabulek źıskaných jako výstupy kódu do podoby LATEXové tabulky. Prostřed-
nictv́ım funkce xtable() umožňuje konverzi objekt̊u r̊uzných datových typ̊u (např. numeric, integer, data.frame,
tibble, apod.) na objekty typu xtable. Objekt typu xtable má tvar tabulky, a to podle nastaveńı bud’ v podobě
LATEXového kódu, nebo v podobě HTML kódu. V kombinaci s funkćı print() pak můžeme libovolný datový objekt
převést na objekt typu xtable a následně jej v rámci kompilace zdrojového kódu automaticky vysázet jako LATEXovou
tabulku.

1.2.3 Nastaveńı RStudia pro tvoru dynamických dokument̊u

Po instalaci baĺıčk̊u knitr a xtable zbývá doladit nastaveńı RStudia. V hlavńı nab́ıdce vybereme panel Tools → Global
Options.... V okně Options vybereme v nalevo umı́stěném vertikálńım panelu záložku Sweave. Tato záložka obsahuje
veškerá nastaveńı RStudia souvisej́ıćı s tvorbou dynamických dokument̊u prostřednictv́ım Sweave.

Ukázka opimálńıho nastaveńı RStudia pro tvorbu dynamických dokument̊u prostřednicv́ım záložky Sweave v
panelu Tools → Global Options... je zobrazena na obrázku 1. Závěrem mějme paměti, že k tomu, aby kompilace
zdrojového kódu proběhla úspěšně na r̊uzných poč́ıtač́ıch, je třeba, aby nastaveńı v panelu Tools → Global Options...
→ Sweave bylo na těchto poč́ıtač́ıch (s výjimkou volby prohĺıžeče) shodné.
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Obrázek 1: Ukázka optimálńıho nastaveńı RStudia pro tvorbu dynamických dokument̊u
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1.3 Vytvořeńı nového .Rnw souboru

Po nastaveńı RStudia pro tvorbu dynamických dokument̊u můžeme přistoupit k vytvořeńı našeho prvńıho dyna-
mického dokumentu. Práci na novém dynamickém dokumentu započneme vytvořeńım .Rnw souboru pomoćı panelu
File → New File → R Sweave (viz obrázek 2). Po zvoleńı uvedené kombinace se vytvoř́ı .Rnw soubor (viz obrázek
3). Kliknut́ım na ikonu diskety, nebo pomoćı panelu File → Save As .Rnw soubor pojmenujeme a ulož́ıme do naš́ı
pracovńı složky. Název souboru voĺıme rozumně, bez mezer a bez diakritiky, jinak soubor nebude pracovat
správně. Po uložeńı naṕı̌seme do těla dokumentu libovolný text (pro začátek bez diakritiky) a klikneme na ikonu
Compile PDF (viz obrázek 4 vlevo). Uvedený .Rnw soubor se zkompiluje a źıskáme .pdf soubor obsahuj́ıćı námi
zapsaný text (viz obrázek 4 vpravo).

Obrázek 2: Ukázka vytvořeńı nového .Rnw souboru

Obrázek 3: Ukázka nově vytvořeného .Rnw souboru
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Obrázek 4: Ukázka kompilace .Rnw souboru (vlevo) a výsledek kompilace (vpravo)
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1.4 Využit́ı šablony s přednastavenou hlavičkou dynamického dokumentu

Pokud se vám povedlo sv̊uj prvńı .Rnw soubor zkompilovat, můžeme se posunout dál. Ve studijńıch materiálech je
k dispozici soubor 01-SI-II-Sablona.Rnw. Tento soubor typu .Rnw (tedy stejného typu, jako právě vytvořený prvńı
.Rnw soubor) obsahuje šablonu pro .Rnw soubor. Šablona má nadefinovanou hlavičku pevné složky, v rámci které je

zadefinován soubor základńıch LATEXbaĺıčk̊u a dále nastaveńı vlastńıho prostřed́ı pro -kód a výstupy kódu.
V těle dokumentu je potom uvedena prvotńı ukázka dynamické složky, jej́ıž prostřed́ı je zahájeno symboly <<>>=
a zakončeno symbolem @ (ukázka šablony viz obrázek 5).

Vaš́ım úkolem nyńı je uvedenou šablonu stáhnout, kompletně nakoṕırovat do vašeho prvńıho .Rnw souboru a sou-
bor zkompilovat, abyste se přesvědčili, že se šablona na vašem poč́ıtači překompiluje bez problémů. Po úspěšném
zkompilováńı si šablonu detailně prostudujte, abyste j́ı rozumněli. V př́ıpadě, že se vám přednastavené prostřed́ı

kódu a jeho výstup̊u bude ĺıbit a že se vám s šablonou bude dobře pracovat, můžete tuto šablonu ze začátku
použ́ıvat jako výchoźı šablonu pro práci s .Rnw soubory. Věř́ım, že časem si najdete vlastńı styl, který vám vyhovuje
a šablonu si modifikujete k obrazu svému :).

K pochopeńı šablony se vám budou hodit informace o univerzálńım sázeńı diakritiky uvedené v sekci 1.5 a dále
popisy vybraných argument̊u dynamických prostřed́ı uvedené v sekci 1.6.1.

1.5 Univerzálńı sázeńı diakritiky

Při vytvářeńı .Rnw soubor̊u s českou či slovenskou diakritikou muśıme poč́ıtat, s r̊uzným kódováńım poč́ıtač̊u.
Nekompatibilńı kódováńı vede k tomu, že na jednom poč́ıtači se text souboru překompiluje bez chyby a na jiném
poč́ıtači bude výstupem kompilace

”
rozsypaný čaj“. Nejjednodušš́ı zp̊usob, jak zajistit, aby námi vytvořený zdro-

jový kód Rnw souboru byl kompatibilńı pro každý poč́ıtač, je sázet ṕısmena s diakritikou pomoćı následuj́ıćıch
LATEXpř́ıkaz̊u.

� v textu:

– čárka: \’a . . . á

– háček: \v{ r } . . . ř;

– kroužek: \r{ u } . . . ů;

� v těle dynamického prostřed́ı:

– čárka: \\’a . . . á;

– háček: \\v{ r } . . . ř;

– kroužek: \\r{ u } . . . ů.
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Obrázek 5: Předdefinovaná šablona dynamického dokumentu
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1.6 Vybrané argumenty dynamického prostřed́ı

V tomto odstavci si uvedeme přehled základńıch argument̊u, které můžeme definovat v záhlav́ı každého dyna-
mického prostřed́ı a se kterémi se setkáte při vytvářeńı vašeho prvńıho Rnw souboru. Rozš́ı̌rený přehled (nejen zde
uvedených) argument̊u dynamického prostřed́ı je k dispozici na webové adrese https://yihui.name/knitr/options/.

Uvedené argumenty je možné vkládat bud’ do dynamického prostřed́ı << setup >>= . . . @ jako argumenty funkce
opts chunk$set(), nebo př́ımo do hlaviček dynamických prostřed́ı. Argumenty definované v prostřed́ı << setup >>=
opts chunk$set(. . . ) @ funguj́ı jako defaultńı nastaveńı každého dynamického prostřed́ı, neńı-li v hlavičce dyna-
mického prostřed́ı tento argument vyloženě definován jinak. Např. pokud bychom zapsali opts chunk$set(echo =
T), znamená to, že kód uvedený v každém dynamickém prostřed́ı <<>>= . . . @ se po překompilováńı automa-
ticky vyṕı̌se ve výsledném .pdf souboru, aniž bychom v hlavičce každého dynamického prostřed́ı museli zapisovat
<< echo = T >>=. Pokud bychom v některém dynamickém prostřed́ı chtěli vypsáńı kódu potlačit, muśıme v
hlavičce dynamického prostřed́ı explicitně zapsat << echo = F >>=.

1.6.1 Argumenty nastavené defaultně pro všechna dynamická prostřed́ı

� platnost těchto argument̊u se vztahuje ke všem dynamickým prostřed́ı v .Rnw souboru, neńı-li v hlavičce
dynamického prostřed́ı tento argument definován jinak

� jde o argumenty, které v naš́ı šabloně figuruj́ı v prostřed́ı << setup >>= . . . @ jako argumenty funkce
opts chunk$set(); tyto argumenty tedy specifikuj́ı automatická nastaveńı pro všechna dynamická prostřed́ı;
poznamenejme, že do prostřed́ı << setup >>= opts chunk$set() @ můžete podle vlastńıho uvážeńı libovolné
argumenty přidávat, nebo odeb́ırat.

Seznam argument̊u

� setup . . . dynamické prostřed́ı s t́ımto záhlav́ım umožňuje vytvořit defaultńı nastaveńı všech dynamickcých
prostřed́ı;

� root.dir = ” ” . . . automatické nastaveńı složky, ve které je .Rnw soubor uložený, jako aktuálńıho adresáře;

� fig.path = ”01-Figure/figure-” . . . v kombinaci s př́ıkazem root.dir = ” ” docháźı k tomu, že v aktuálńım adresáři
se vytvoř́ı složka 01-Figure a do této složky se budou vkládat všechny obrázky, které se během kompilace .Rnw
souboru vytvoř́ı; název každého obrázku bude zač́ınat slovy figure-;

� fig.show = ”hold” . . . vygenerované obrázky se vykresĺı pod sebe, všechny obrázky budou mı́t dohromady jeden
společný popisek shodný s popiskem v argumentu fig.cap = ”. . . ”;

� fig.align = ”center” . . . vygenerované obrázky se automaticky zarovnaj́ı na střed (tj. uprostřed mezi pravým a
levým okrajem stránky);

� fig.pos = ”ht” . . . je-li to možné, vygenerovaný obrázek se umı́st́ı v textu na stejnou pozici, jako ve zdrojovém
kódu (plovoućı umı́stěńı obrázku); neńı-li to možné, umı́st́ı se na začátek stávaj́ıćı, nebo následuj́ıćı stránky;

� highlight = T . . . kód zobrazený ve zkompilovaném .pdf souboru je automaticky zabarvován barevně v souladu s
barevným nastaveńım kódu podle protokolu R Sweave (plat́ı pouze v př́ıpadě, že za př́ıkazem opts chunk$set()
nenásleduje silněǰśı př́ıkaz render listings(), který přeb́ıj́ı defaultńı nastaveńı vlastńım nastaveńım definovaným
v hlavičce dokumentu)

� highlight = F . . . kód zobrazený ve zkompilovaném .pdf souboru je automaticky zabarvován černob́ıle v
souladu s černob́ılým nastaveńım kódu podle protokolu R Sweave (plat́ı pouze v př́ıpadě, že za př́ıkazem
opts chunk$set() nenásleduje silněǰśı př́ıkaz render listings(), který přeb́ıj́ı defaultńı nastaveńı vlastńım nasta-
veńım definovaným v hlavičce dokumentu)
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1.6.2 Argumenty, se kterými se v šabloně setkáte v hlavičkách jednotlivých dynamickýh prostřed́ı

� (platnost těchto argument̊u se vztahuje pouze k jednomu dynamickému prostřed́ı)

Seznam argument̊u:

� echo = T . . . vypǐs kód; echo = F . . . nevypisuj kód;

� eval = T . . . vyhodnot’ př́ıkazy v dynamickém prostřed́ı; eval = F . . . nevyhodnocuj př́ıkazy v dynamickém
prostřed́ı (př́ıkazy se nevyhodnot́ı; klasické výsledky př́ıkaz̊u, obrázky, animace nebo tabulky se nevyṕı̌śı);

� results = ”asis” . . . výstup vysázej tako LATEXtabulku;

� warning = F . . . varováńı (warnings), která prováźı výstup funkce, se nevyṕı̌śı; warning = T . . . varováńı, která
prováźı výstup funkce se vyṕı̌śı;

� message = F . . . zprávy, které prováźı výstup funkce, se nevyṕı̌śı; message = T . . . zprávy, které prováźı výstup
funkce, se vyṕı̌śı;

� fig.height = 5 . . . absolutńı výška obrázku (nejčastěji voĺıme hodnotu mezi 3–15, lze ale volit vyšš́ı i nižš́ı č́ısla;
č́ım je hodnota fig.height vyšš́ı, t́ım je obrázek větš́ı, a popisky v grafu menš́ı);

� fig.width = 5 . . . absolutńı š́ı̌rka obrázku (nejčastěji voĺıme hodnotu mezi 3–15, lze ale volit vyšš́ı i nižš́ı č́ısla;
č́ım je hodnota fig.height vyšš́ı, t́ım je obrázek větš́ı, a popisky v grafu menš́ı; pokud fig.height = fig.width,
je obrázek čtvercový);

� out.width = ”0.44\\linewidth” . . . relativńı velikost obrázku vzhledem k délce jednoho řádku (1\\linewidth
. . . graf je v rozsahu od levého okraje textu k pravému okraji textu; 0.5\\linewidth . . . graf má velikost poloviny
š́ı̌rky rozsahu textu, apod.;

� fig.cap = ”\\label{Malajsie} Popisek obr\\’azku” . . . vytvář́ı popisek obrázku

� fig.show = ”animate” . . . vygenerované obrázky se nevykresĺı pod sebe, ale automaticky se poskládaj́ı do
animace (efektivńı a elegantńı tvorba animace);

� fig.show = ”asis” . . . vygenerované obrázky se vykresĺı pod sebe, každý obrázek bude mı́t popisek shodný s
popiskem v argumentu fig.cap = ”. . . ”;

� fig.show = ”hold” . . . vygenerované obrázky se vykresĺı pod sebe, všechny obrázky budou mı́t dohromady jeden
společný popisek shodný s popiskem v argumentu fig.cap = ”. . . ”.
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1.7 Argumenty př́ıkaz̊u xtable() a print.xtable()

Praktickou vlastnost́ı dynamických dokument̊u je, že tabulkový výstup funkćı dokážeme automaticky přetransformovat
na LATEXtabulku. K tomu použ́ıváme kombinaci př́ıkaz̊u xtable() (viz nápověda funkce xtable) a print() (viz nápověda
funkce print.xtable). Zde si uvedeme přehled vybraných argument̊u obou funkćı, se kterými se v rámci vypracováńı
samostatné práce setkáte.

Vybrané argumenty funkce xtable()

� align = ”l||rrrrr” . . . definuje zarovnáńı sloupc̊u tabulky, jako to známe z vytvářeńı tabulek v LATEXu;

� digits = rep(4, 6), . . . definuje zaokrouhleńı č́ısel ve sloupćıch tabulky;

� caption = ”Popisek tabulky” . . . definuje zněńı popisku tabulky;

� label = ”Odkaz” . . . definuje název odkazu tabulky; na tabulku se potom můžeme v textu odkazovat klasicky
pomoćı př́ıkazu ref().

Vybrané argumenty funkce print.xtable()

� caption.placement = ”top” . . . popisek tabulky se umı́st́ı nad tabulku;

� hline.after = c(0, 2) . . . definujeme, pod kterými řádky tabulky se vykresĺı vodorovná čára (hline.after = c(0,
2) znač́ı, že se vykresĺı dvě čáry, jedna pod nultým řádkem, tj. pod hlavičkou tabulky, a jedna pod druhým
řádkem tabulky;

� include.rownames = T . . . do LATEX tabulky se zahrnou názvy řádk̊u p̊uvodńı tabulky typu data.frame;

� include.rownames = F . . . do LATEX tabulky se nezahrnou názvy řádk̊u p̊uvodńı tabulky typu data.frame;

� include.colnames = T . . . do LATEX tabulky se zahrnou názvy sloupc̊u p̊uvodńı tabulky typu data.frame;

� include.colnames = F . . . do LATEX tabulky se nezahrnou názvy sloupc̊u p̊uvodńı tabulky typu data.frame;

� add.to.row = addtorow . . . do LATEX tabulky se doplńı řádky podle seznamu uvedeného v proměnné addtorow;
je-li v proměnné addtorow zadefinován řádek na pozici 0, je t́ım myšlena hlavička tabulky;

� sanitize.text.function = function(x) x . . . je-li v p̊uvodńı tabulce typu data.frame v názvu řádku vložen LATEX vzorec
(např. ”\\sum”), argument sanitize.text.function = function(x) x zajist́ı, že se vzorec přelož́ı a symbol

∑
se po

kompilaci vysáźı správně;

� table.placement = ”H” . . . je-li to možné, tabulka se umı́st́ı na pozici v textu, kde je tabulka umı́stěna ve
zdrojovém kódu (analogie argumentu fig.pos = ”h” u umı́stěńı obrázk̊u).
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2 Řešeńı samostatné práce

Nyńı již máte k dispozici veškeré informace o dynamických dokumentech a argumentech dynamických prostřed́ı,
které potřebujete k vypracováńı samostatné práce. Nı́že máte k dispozici kód, pomoćı kterého můžete sv̊uj prvńı
dynamický dokument vytvořit.

Při vytvářeńı dynamického dokumentu postupně zpracovávejte jednotlivé části uvedeného kódu a po dokončeńı
každého dynamického prostřed́ı si .pdf soubor zkompilujte, abyste měli jistotu, že pracujete bez chyb. Při přepisováńı
kódu se soustřed’te na jednotlivé části kódu a uvědomujte si, k čemu které argumenty a př́ıkazy slouž́ı. Snažte se
kód co nejlépe pochopit a klidně si zkoušejte části kódu r̊uzně modifikovat a zkoumejte, co modifikace zp̊usobuj́ı :).

Obrázek 6: Řešeńı zadáńı samostatné práce 1/4
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Obrázek 7: Řešeńı zadáńı samostatné práce 2/4
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Obrázek 8: Řešeńı zadáńı samostatné práce 3/4
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Obrázek 9: Řešeńı zadáńı samostatné práce 4/4
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